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Getting Started
Overview of M7CL V2 Editor
M7CL V2 Editor (hereinafter called “M7CL Editor” in this document) enables you to remotely control a Yamaha
M7CL mixing console (Version 2) (such as M7CL-48 or M7CL-32; hereinafter collectively called “M7CL” in this document). M7CL V2 Editor also enables you to save the parameter settings on your computer. To use M7CL Editor, you
must first perform the following operations:
1 Start and configure Studio Manager.
2 Start and configure M7CL Editor.
3 Synchronize M7CL Editor with your M7CL console (➥ p.8).
NOTE

For more information on using Studio Manager, refer to the Studio Manager Owner’s Manual.

Configuring M7CL Editor
You must configure the following settings for each open Editor.
NOTE

• Before you make the following settings, you must make settings for the DME-N Network Driver and
select the MIDI port in the Setup window of Studio Manager.
• To open an editor, double-click the icon for the desired editor in the Studio Manager window.

❏ System Setup
To open the System Setup window, choose [System Setup] from the [File] menu.
NOTE

Be sure to specify the Input port and Output port.

A Input port/Output port
From the ports you specified in Studio Manager, select the ports that the editor will use
to communicate with the M7CL console.

B Fast Sync
This allows synchronization to be speed up,
reducing the time required. Use this check
box to choose whether to enable this function.

C Window Control from Console
This option determines whether or not using
the USER DEFINED KEYS on the console
enables you to remotely open and close the
M7CL Editor windows.

1
5

2

3
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4

D Level Meter
By disabling the meter function you can reduce the processing load caused by screen drawing and communication. This option specifies whether the level meter functionality will be enabled.

E Confirmation
These check boxes specify whether a confirmation dialog box will appear when you store (Store Confirmation),
recall (Recall Confirmation), patch (Patch Confirmation), or make a patch change that would modify an existing
patch (Steal Patch Confirmation).

F Administrator Password
Enter the Administrator password that was specified on the M7CL console. If this password is not entered correctly, it will not be possible to synchronize from M7CL Editor to the M7CL console.
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❏ Mixer Setup
To open the Mixer Setup window, choose [Mixer Setup] from the [File] menu.

1
2

3

A Input Channels
Specify the number of input channels on the M7CL console. When the editor is synchronized with the M7CL
console, the actual number of channels on the M7CL console will automatically be specified here.

B Mix Bus Setup
Here you can make settings relating to the MIX buses.
Signal Type: Choose either MONOx2 or STEREO for each two adjacent odd-numbered/even-numbered MIX
buses.
Bus Type/Send Point: Choose either VARI (PRE FADER) or VARI (PRE EQ) or FIXED for each two adjacent odd-numbered/even-numbered MIX buses.
Pan Link: This is valid only if the Signal Type is set to STEREO and the Bus Type is set to VARI. If this is
enabled, the pan setting sent to stereo MIX buses will be linked with the pan setting to the STEREO bus.

C Matrix Bus Setup
Here you can make settings relating to the MATRIX buses.
Signal Type: Choose either MONOx2 or STEREO for each two adjacent odd-numbered/even-numbered
MATRIX buses.
Bus Type/Send Point: Choose either PRE FADER or PRE EQ for each two adjacent odd-numbered/evennumbered MATRIX buses.
Pan Link: This is valid only if the Signal Type is set to STEREO and the Bus Type is set to VARI. If this is
enabled, the pan setting sent to stereo MATRIX buses will be linked with the pan setting to the STEREO bus.

3

M7CL V2 Editor Owner’s Manual

❏ Creating a user key
To open the Create User Key window, choose [Create User Key] from the [File] menu.
This creates a user key (with “.M7U” file name extension) that can be read from a USB storage device by the
M7CL console to automatically set user-specific parameters.

1 3
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A User Name
Specify the name of the user. You can enter up to eight single-byte characters of alphabet and numerals.

B Comment
Enter a comment for each user. You can enter up to thirty-two single-byte alphanumeric characters.

C Password
Enter a password that will be used when this user key is read by the M7CL console. You can enter up to eight single-byte alphanumeric characters. Uppercase and lowercase are distinguished.

D Re-Enter Password
Enter the password once again as a safeguard against mistaken entry.

E POWER USER
Specify whether this user is a power user. Power users can use the M7CL console to create or edit a user authentication key with a specified user level.

F Administrator Password
Enter the Administrator password that was specified on the M7CL console. This is not required if no Administrator password has been specified on the M7CL console, but if this password is incorrect you will be asked to enter
it when the user key is read.

G ACCESS PERMISSION
In this area, specify the parameters that this user will be allowed to operate.
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H CH OPERATION
INPUT, ST IN, DCA, MIX, MATRIX, ST/MONO: Select the channels whose parameters will be operable.
HA: Change the operating privileges for the head amp gain and phantom power of the selected channels.
PROCESSING: Change the operating privileges for overall signal processing parameters (except for fader
and [ON] key) of the selected channel. For the specific parameters included in PROCESSING, refer to the
appendix of the M7CL owner’s manual.
FADER/ON: Change the operating privileges for the pan/balance, fader, channel on, send on/off, and send
level of the selected channels.
Set All: Turn on HA, PROCESSING, and FADER/ON for all channels.
Clear All: Turn off HA, PROCESSING, and FADER/ON for all channels.
Set by One Click: If this button is on, HA, PROCESSING, and FADER/ON will all be turned on when you
select a channel. If all are already on, all will be turned off.

I SCENE LIST
STORE/SORT: Change the operating privileges for scene store and sort operations.
RECALL: Change the operating privileges for scene recall operations.

J LIBRARY LIST
STORE/CLEAR: Change the operating privileges for library store and clear operations.
RECALL: Change the operating privileges for library recall operations.

K FILE LOAD
USER SETUP: Change the operating privileges for loading user-defined keys and preferences when loading a
file.
SYSTEM SETUP MONITOR SETUP: Change the operating privileges for loading system setup and monitor setup settings when loading a file.
CURRENT SCENE: Change the operating privileges for loading the current scene when loading a file.
SCENE LIST: Change the operating privileges for loading the scene list when loading a file.
LIBRARY LIST: Change the operating privileges for loading the library list when loading a file.

L CURRENT SCENE
INPUT PATCH: Change the operating privileges for input patch operations.
INPUT NAME: Change the privileges for editing the input names.
OUTPUT PATCH: Change the operating privileges for output patching.
OUTPUT NAME: Change the privileges for editing the output names.
BUS SETUP: Change the operating privileges for buses.
RACK: Change the operating privileges for rack operations.
MUTE GROUP ASSIGN: Change the privileges for assigning mute groups.
MUTE GROUP MASTER: Change the operating privileges for enabling/disabling mute groups.

M MONITOR SETUP
OSCILLATOR: Change the operating privileges for oscillator settings.
TALKBACK: Change the operating privileges for talkback settings.

N SYSTEM SETUP
MIXER SETUP: Change the privileges for making mixer setup settings.
OUTPORT SETUP: Change the privileges for making outport setup settings.
MIDI: Change the privileges for making MIDI settings.

O Create
Creates the user key.

P Cancel
Closes the window.
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Working with Sessions
All of your console’s mix settings in M7CL Editor, including Scene and library data, are called Sessions.
The following table describes how to handle Sessions.
Creating a new Session
Opening a previously saved Session
Saving the current Session
Saving the current Session with a new name

Choose [New Session] from the [File] menu.
Choose [Open Session] from the [File] menu.
Choose [Save Session] from the [File] menu.
Choose [Save Session As...] from the [File] menu.

When you save a session in the window of an editor, the settings of only that editor will be saved in a file. Session files
saved by M7CL Editor have a filename extension of “.YSE”. Files in which only the M7CL console data is saved (filename extension “.M7C”) can also be handled, allowing you to use a USB storage device to exchange data with the
M7CL console.
If you save a Session in the Studio Manager window, all selected Editor settings are saved in a file with a file extension
of “.YSM.”
NOTE With M7CL V2 Editor, you can open files that include the extension “.M7C” or “.YSE” that have been
saved on the M7CL Version 1 console or in M7CL Editor Version 1, but not vice versa. That is, with the
M7CL Version 1 console or M7CL Editor Version 1, you cannot open files that have been saved in M7CL
V2 Editor.

Undo/Redo Function
In M7CL Editor, you can cancel the latest operation (Undo) and also cancel the cancellation of the latest operation
(Redo). If you perform an Undo operation twice in a row, you can cancel the two most-recent operations. If you perform an Undo operation three times in a row, you can cancel the three most-recent operations. In this way, you can
cancel multiple recent operations. The following table describes how to use the Undo/Redo function.
Undo
Redo

Choose [Undo] from the [Edit] menu.
Choose [Redo] from the [Edit] menu.

Please note, however, that after you perform one of the following operations, you cannot successfully undo or redo
any previous operation:
• Operations on the M7CL console
• Quitting Studio Manager
• Synchronizing with the M7CL console
• Session operations
NOTE

You cannot Undo or Redo the following operations:
• Edits in the Setup window
• Synchronization
• Opening and closing the windows
• Resizing or moving the windows
There are certain other operations that cannot be undone, depending on the function.

NOTE

For library or scene operations, Undo/Redo applies only to the single most recent operation. You cannot
undo any operations prior to this. Undo/Redo in these windows is available only using the [UNDO] button
within the respective window. Even if you perform a scene recall from the Master window, you cannot use
a shortcut or menu operation to undo the recall.
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Window operations
You can select and open each window from the [Windows] menu. For the INPUT CH window and Effect Editor window, use the sub-menu to select the channels or
library you want to see.

You can choose Tile or Cascade to arrange the windows within the editor.
● Tile

● Cascade

In the Library window or Scene window, click the tabs
located at the top of the window to switch between
pages.
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Synchronizing M7CL Editor
When M7CL Editor starts up, the parameter settings on the console and the parameter settings in M7CL Editor may
be different. Therefore, you must first match the parameter settings on the console with those in M7CL Editor. This
operation is called “synchronization.” Follow the steps below to synchronize M7CL Editor.
1 Select [Synchronize], then [Re-synchronize].
The following window opens.
2 Select whether you want to transfer your settings to M7CL
Editor, or vice versa.
At this time, the All Libs option determines whether or not Scene and
Library data is synchronized.
PC ➔ Console: Transfers the current parameter settings in M7CL Editor to your console.
Console ➔ PC: Transfers the current parameter settings of your console to the M7CL Editor.
3 Click [OK].
Do not operate the console while synchronization is in progress.
NOTE

If you use the “Total Recall” function in Studio Manager, all selected Editors in Studio Manager are synchronized with the corresponding devices.

Offline Edit Function
If you do not want to synchronize your console with M7CL Editor, select [Offline Edit] from the [Synchronization]
menu. To apply your off-line edits to your console, select [Re-Synchronize] from the [Synchronization] with the PC
-> Console option to synchronize the console with M7CL Editor.
The Offline Edit function is also activated when you click the [ONLINE]/[OFFLINE] button in the Sync window.
NOTE

Some effect parameters in the console change their displayed values depending on the sampling frequency. If you switch M7CL Editor from OFFLINE to ONLINE, displayed parameter values may change
because M7CL Editor loads the sampling frequency from the console and updates the display.

Other Functions
❏ Resetting to the default value (Ctrl+click)
Move the cursor to a control or a parameter value, then hold down the <Ctrl> key and click the mouse button to
reset the value to the default (e.g., to reset a pan setting to Center).
However, the channel faders and the send knobs and bar graphs can be set to –∞ regardless of the default value.

❏ Ctrl+Shift+Click
Move the mouse cursor to a channel fader or to a send knob or bar graph, and click while holding down the
<Ctrl> key and <Shift> key to set the nominal value regardless of the default value.
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Master window

In the Master window you can synchronize to the M7CL itself, recall scenes, and display the Overview window. To
open this window, choose [Master] from the [Windows] menu.

❏ CHANNEL SELECT
This indicates the number and name of the channel to which your operations will apply. To
switch channels, you can either click the [SELECT] button and choose from the list that
appears, or you can click the left/right arrow-shaped channel select buttons. You can also
use the channel name text box to edit the name.
This is linked with the [SEL] keys on the M7CL itself.
You can right-click the icon to select a different one.

❏ SYNC
This indicates the status of connection and synchronization between M7CL Editor and the M7CL.

A [ONLINE]/[OFFLINE] button
12

The ONLINE/OFFLINE status will alternate each time you click this button.
This has the same function as [Synchronization] menu ➔[Offline Edit]. (➥ p.8)
This indicator is shown when M7CL Editor is correctly connected to the M7CL itself. In this state, the parameters of M7LC
Editor and the M7CL itself are linked.
This indicator is shown when M7CL Editor and the M7CL itself
are not connected, or when there is a problem with the connection, or when Offline Edit is selected. In this state, the parameters of M7CL Editor and the M7CL itself are not linked.

B [RE-SYNC] button
Clicking this button opens the Synchronization dialog box.
This has the same function as [Synchronization] menu ➔ [Re-Synchronize]. (➥ p.8)

9

M7CL V2 Editor Owner’s Manual

❏ SCENE MEMORY
Here you can view the currently-recalled scene, and recall or store scenes.

A Scene number display
1
2
3

Indicates the number of the scene that is selected for store or recall.

BProtect indicator
The lock icon is displayed for scene memories that are protected.

4
5
6

CEdit indicator
The edit indicator will light when you edit the parameters after recalling a scene.

D [STORE] button
This button stores the current scene into the number shown by the scene number display (1).

E [▲]/[▼] buttons
These buttons increment or decrement the number shown in the scene number display
(1). The scene number display (1) will blink until you actually store or recall, and
while blinking will not match the scene number indicated on the M7CL.

F [RECALL] button
This button recalls the scene of the number shown in the scene number display ( 1).

❏ Navigation Keys
These keys open various windows.
NOTE

These are not linked with the navigation key section on the panel of the M7CL itself.

67 8
A [17-32] button
Opens the INPUT CH 17–32 window.

1
2

B [1-16] button

3
4

C [ST IN] button

Opens the INPUT CH 1–16 window.

5

Opens the ST IN window.

D [DCA] button
Opens the DCA window.

E [STEREO] button
Opens the STEREO/MONO window.

F [MIX] button
Opens the MIX window.

G [MTRX] button
Opens the MATRIX window.

H [33-48] button
Opens the INPUT CH 33–48 window. This is available only during offline editing and
when 48 is selected as the number of input channels in the Mixer Setup window, or
when editing online with the M7CL-48.
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Overview window
INPUT CH window

This window displays the mix parameters of INPUT CH 1–16, 17–32, or 33–48 (*). The parameters shown in the
window can be selected from the [View] menu or the menu that appears when you right-click in the window.
You can access this window in the following ways.
●
●
●

From the [Windows] menu, choose [Overview] and select “CH1-16” / “CH17-32” / “CH33-48”(*)
Use the navigation keys in the Master window to turn on the [1-16] button / [17-32] button / [33-48] button(*)
On the M7CL itself, assign one of the USER DEFINED KEYS to [1-16]/[17-32]/[33-48](*) in [INPUT CH] of [M7CL
EDITOR CONTROL], and execute the function
(*)

INPUT CH 33-48 can be viewed only if 48 is selected in the Input Channels field of the Mixer Setup window when editing offline, or
when editing online with the M7CL-48.

A Input patch
1
2
3

Click here to select the input source that will be assigned to the INPUT CH, from the
following choices.
NONE

No assignment

IN1–IN48(*)

INPUT jacks 1–48(*)
L/R channels of ST IN jacks 1–4
Input channels of an I/O card installed in slots
1–3
L/R outputs of Rack 1–8

STIN1L–STIN4R
SLOT1-1, SLOT1-2...SLOT3-15, SLOT3-16
RACK1A, RACK1B...RACK8R(B)

(*) AD33–48 (INPUT jacks 33-48) can be viewed only if 48 is selected in the Input Channels field of the
Mixer Setup window when editing offline, or when editing online with the M7CL-48.

B HA GAIN
Drag the knob in the screen to adjust the gain of the internal head amp or of the external head amp (AD8HR) patched to the INPUT CH.

C 48V
Switches on/off the phantom power (+48V) of the internal head amp or of the external
head amp (AD8HR) patched to the INPUT CH.
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D Ø (Phase)
Inverts the phase of the signal after AD conversion.

4
5
6
7
8

E HPF (High Pass Filter)
Switches the high pass filter on/off. You can drag the numeric value up or down to edit
the cutoff frequency.

F INS (Insert)
Enables/disables the insert-in.

G D. OUT (Direct out)
Enables/disables the direct output.

H EQ (Equalizer)

9

Switches the EQ on/off. The graph immediately below the button shows the approximate response of the EQ. You can drag within the graph to edit the response of the EQ.
To reset the EQ to flat response, hold down the <Ctrl> key of your computer keyboard
and click the grap (The HPF setting will remain).

I DYN1/DYN2 (Dynamics 1/Dynamics 2)
J

Turns the two dynamics processors on/off.
If Gate is assigned (Dynamics 1 only), the status of the gate is shown immediately below
the button.
Gate status
indication
On/off status

On

On

On

Off

Open/closed
status

Closed

Open

Open

—

Gain reduction amount
is 30 dB or more

Gain reduction
amount is 0–30 dB

Remarks

Gain reduction
amount is 0 dB

—

If something other than Gate is assigned, a GR meter is shown immediately below the
button, and the amount of gain reduction is shown while this is on.
The type for each dynamics processor can be selected in the Selected Channel window.

J MIX/MATRIX SEND
Switches between the send indications to MIX buses
1–16 and to MATRIX buses 1–8.
The bar graphs located immediately below the button
show the send level of the signals sent from the INPUT
CH to VARI type MIX/MATRIX buses. You can also
drag the bar graph to left or right to set the send level.
While you drag the bar graph, the send level is shown
in the numerical display area for PAN/TO STEREO
MONO (K).
You can set the minimum value (–∞ dB) by holding
down the <Ctrl> key of your computer keyboard and
clicking the bar graph, or set the nominal value
(0.00 dB) by holding down the <Ctrl> key and <Shift>
key and clicking the bar graph.
The bar graph display will change according to the
send position (pre/post) and on/off status of the signal
sent from the INPUT CH to the MIX/MATRIX buses.
To switch a send on/off, click the channel number
located at the left of the bar graph.
NOTE

• Pre/on (green)
• Pre/off (green)
• Post/on (yellow)
• Post/off (yellow)

For FIXED-type MIX buses, the bar graph is fixed at nominal level (0 dB),
and only the on/off status is shown.
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K PAN/TO STEREO MONO
K
L
M
N

O

The PAN knob adjusts the panning of the signal that is sent from the INPUT CH to the
STEREO bus L/R channels (or the L/C/R channels). You can set this to the center value
by holding down the <Ctrl> key of your computer keyboard and clicking this knob.
The [ST] button is an on/off switch for the signal that is sent from the INPUT CH to
the STEREO bus.
The [M(C)] button is an on/off switch for the signal that is sent from the INPUT CH to
the MONO bus.
If LCR MODE is selected in the Selected Channel window, the [LCR] button will appear
instead of the [ST] button and [M(C)] button, and the [LCR] button will be an on/off
switch for the signal that is sent from the INPUT CH to the LCR bus.

L SEL (Select)
Selects the INPUT CH for which you want to perform operations. This is linked with
the INPUT section [SEL] keys on the M7CL’s panel.

M CUE
This button cue-monitors the signal of the INPUT CH. This is linked with the INPUT
section [CUE] keys on the M7CL’s panel.

N ON
P
Q

Switches the INPUT CH on/off. This is linked with the INPUT section [ON] keys on
the M7CL’s panel.

O Fader
Adjusts the input level of the INPUT CH. When the M7CL itself is in other than SENDS
ON FADER mode, this is linked with the INPUT section faders of the M7CL’s panel.
The current fader value is shown in the numerical box located immediately below the
fader.
You can set this to the minimum value (–∞ dB) by holding down the <Ctrl> key of
your computer keyboard and clicking the fader knob, or set it to the nominal value
(0.00 dB) by holding down the <Ctrl> key and <Shift> key and clicking the fader knob.
The numbers and alphabetical letters at the right
of the fader indicate the
DCA group and mute
groups to which that
channel belongs, and
show the Recall Safe and
Mute Safe status of the
channel.

The numbers of DCA groups to which this
channel belongs are shown in yellow.
The numbers of mute groups to which this
channel belongs are shown in red.
If this channel is set to Recall Safe, the R
character is shown in green.
If this channel is set to Mute Safe, the M character is shown in green.

P Channel number
This is the number of the INPUT CH. You can open the Selected Channel window for
this channel by double-clicking this number. If you hold down the <Ctrl> key of your
computer keyboard and double-click this, the Selected Channel window will open as an
additional view.

Q Channel name
This is a text box that displays the channel name. You can also edit the channel name in
this text box.
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ST IN window

In this window you can view and edit the mix parameters of ST IN channels 1–4. The parameters shown in the window can be selected from the [View] menu or the menu that appears when you right-click in the window.
You can access this window in the following ways.
●
●

1
2
3
4
5
6

From the [Windows] menu, choose [Overview] and then choose “ST IN”
Use the navigation keys in the Master window to turn on the [ST IN] button

A INPUT PATCH
Selects the input source that will be assigned to the ST IN channel. The input sources
that can be assigned are the same as for an INPUT CH (➥ p.11).

B HA GAIN
Drag the knob in the screen to adjust the gain of the internal head amp or of the external head amp (AD8HR) patched to the ST IN channel.

C 48V
Switches on/off the phantom power (+48V) of the internal head amp or of the external
head amp (AD8HR) patched to the ST IN channel.

D Ø (Phase)
Inverts the phase of the signal after AD conversion.

E HPF (High Pass Filter)
Switches the high pass filter on/off. You can drag the numeric value up or down to edit
the cutoff frequency.

F EQ (Equalizer)
Switches the EQ on/off (the L/R settings are linked). This is the same as the equalizer for
INPUT CH (➥ p.12).
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G DYN1/DYN2 (Dynamics 1//Dynamics 2)
7

These buttons switch the two dynamics processors on/off. This is the same as the
dynamics 1/dynamics 2 for INPUT CH (➥ p.12).

H MIX/MATRIX SEND
8

Switches between the send indications to MIX buses 1–16 or to MATRIX buses 1–8.
This is the same as the mix/matrix send for INPUT CH (➥ p.12).

I BALANCE
The BALANCE knob adjusts the balance of the signal that is sent from the ST IN channel to the STEREO bus L/R channels (or the L/C/R channels). Other than the BALANCE knob, this is the same as PAN/TO STEREO MONO for an INPUT channel
(➥ p.13).

J SEL (Select)
9

Selects the ST IN channel for which you want to perform operations. (L and R can be
selected separately.) This is linked with the ST IN section [SEL] keys on the M7CL’s
panel.

J
K
L

K CUE

M

L ON

This button cue-monitors the signal of the ST IN channel (L/R are linked). This is
linked with the ST IN section [CUE] keys on the M7CL’s panel.
Switches the ST IN channel on/off (the L/R settings are linked). This is linked with the
ST IN section CH [ON] keys on the M7CL’s panel.

M Fader
N
O

Adjusts the input level of the ST IN channel. When the M7CL itself is in other than
SENDS ON FADER mode, this is linked with the INPUT section faders of the M7CL’s
panel.
The current fader value is shown in the numerical box located immediately below the
fader. This is the same as the fader for INPUT CH (➥ p.13).

N Channel number
This is the number of the ST IN channel. You can double-click this number to open the
Selected Channel window for this channel. If you hold down the <Ctrl> key of your
computer keyboard and double-click this, the Selected Channel window will open as an
additional view.

O Channel name
This is a text box that displays the channel name. You can also edit the channel name in
this text box.
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MIX window

In this window you can view and edit the parameters of MIX channels 1–16. The parameters shown in the window
can be selected from the [View] menu or the menu that appears when you right-click in the window.
You can access this window in the following ways.
●
●

1
2

3
4

From the [Windows] menu, choose [Overview] and then choose “MIX”
Use the navigation keys in the Master window to turn on the [MIX] button

A OUTPUT PATCH
Click here to select the output port that will be assigned to the MIX channel, from the
following choices.
OMNI1–OMNI16

OMNI jacks 1–16

SLOT1-1,
SLOT1-2...SLOT3-16

Input channels of an I/O card installed in slot 1–3

RACK1A,
RACK1B...RACK8R(B)

L/R outputs of Rack 1–8

2TROUT L, 2TROUT R

L/R channels of the 2TR OUT DIGITAL jack

If multiple patches have been made, only the first port is shown.
If you change the patching in this window, the port that had been assigned until then
will be cancelled, and only the newly selected port will be assigned.

B EQ (Equalizer)
Switches the EQ on/off. This is the same as the equalizer for INPUT CH (➥ p.12).

C DYN1(Dynamics 1)
Switches the dynamics processor on/off. This is the same as the dynamics 2 for INPUT
CH (➥ p.12).

D INS (Insert)
Enables/disables the insert-in.

16

M7CL V2 Editor Owner’s Manual

E MATRIX SEND
5

6
7
8
9
J

K

These bar graphs indicate the send levels of the signals sent from the • Pre/on (green))
MIX channel to MATRIX 1–8 bus. You can also adjust the send levels by dragging a bar graph to left or right. While you drag the bar
• Pre/off (green)
graph, the send level is shown in the numerical display area for TO
STEREO/MONO.
• Post/on (yellow)
You can set the minimum value (–∞ dB) by holding down the
<Ctrl> key of your computer keyboard and clicking the bar graph, • Post/off (yellow)
or set the nominal value (0.00 dB) by holding down the <Ctrl> key
and <Shift> key and clicking the bar graph.
The bar graph display will change as follows according to the send position (pre/post)
and on/off status of the signal sent from the MIX channel to the MATRIX buses.
To switch a send on/off, click the channel number located at the left of the bar graph.

F PAN/BALANCE
The PAN knob adjusts the panning of the signal that is sent from the mix channel to the
STEREO bus L/R channels (or the L/C/R channels). You can set this to the center value
by holding down the <Ctrl> key of your computer keyboard and clicking this knob. If
assigned as a stereo bus, this adjusts the balance of the odd-numbered channel and
even-numbered channel. The stereo bus setting can be made in Mix Bus Setup of the
Mixer Setup screen.
The [ST] button is an on/off switch for the signal that is sent from the mix channel to
the STEREO bus.
The [MONO] button is an on/off switch for the signal that is sent from the mix channel
to the MONO bus.
If LCR MODE is selected in the Selected Channel window, the [LCR] button will
appear instead of the [ST] button and [MONO] button, and the [LCR] button will be
an on/off switch for the signal that is sent from the mix channel to the LCR bus.

G VARI/FIXED
Indicates the type (VARI or FIXED) of the currently selected MIX bus. This parameter
can be switched in Mix Bus Setup of the Mixer Setup screen.

H SEL (Select)
Selects the MIX channel for which you want to make settings.

L

I CUE
This button cue-monitors the signal of the MIX channel.

J ON
M

Switches the MIX channel on/off.

K Fader
Adjusts the output level of the
The numbers of mute groups to
MIX channel. The current fader
which this channel belongs are
value is shown in the numeric box
shown in red.
immediately below the fader. You
can set this to the minimum value
(–∞ dB) by holding down the
If this channel is set to Recall Safe,
<Ctrl> key of your computer keythe R character is shown in green.
board and clicking the fader knob,
or set it to the nominal value
If this channel is set to Mute Safe,
(0.00 dB) by holding down the
the M character is shown in green.
<Ctrl> key and <Shift> key and
clicking the fader knob.
The numbers and alphabetical letters at the right of the fader indicate the mute groups
to which that channel belongs, and show the Recall Safe and Mute Safe status of the
channel.

L Channel number
Indicates the number of the MIX channel. You can double-click this number to open
the Selected Channel window for this channel. If you hold down the <Ctrl> key of your
computer keyboard and double-click this, the Selected Channel window will open as an
additional view.

M Channel name
This is a text box that displays the channel name. You can also edit the channel name in
this text box.
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MATRIX window

In this window you can view and edit the parameters of MATRIX channels 1–8. The parameters shown in the window can be selected from the [View] menu or the menu that appears when you right-click in the window.
You can access this window in the following ways.
●
●

From the [Windows] menu, choose [Overview] and then choose “MATRIX”
Use the navigation keys in the Master window to turn on the [MTRX] button
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1

A MIX/CH/ST IN (Send levels from the MIX/INPUT CH/ST IN to
the MATRIX bus)
This switches between indicating the sends from MIX channels 1–16, the sends from
INPUT CH 1–16 / 17–32 / 33–48 (*), and the sends from ST IN.

2

The bar graphs located immediately below the button indicate/adjust the level of the
signal that is sent from each channel to the MATRIX bus. The method of operation and
the meaning of the display are the same as for (5) MATRIX in the MIX window
(➥ p.17).
(*)

3

4

INPUT CH 33–48 can be viewed only if 48 is selected in the Input Channels field of the Mixer Setup
window when editing offline, or when editing online with the M7CL-48.

B STEREO (Send levels from the STEREO channels to the MATRIX
bus)
Here you can view and edit the send levels of the signals sent from the STEREO channels to the MATRIX bus. While you drag the bar graph, the send level is shown in the
numerical display area immediately below. The method of operation and the meaning
of the display are the same as for (5) MATRIX in the MIX window (➥ p.17).

C EQ (Equalizer)
5

Switches the EQ on/off. The graph immediately below the button shows the approximate response of the EQ. This is the same as the equalizer for INPUT CH (➥ p.12).

6
7

D DYN1(Dynamics 1)

8

E INS (Insert)

Switches the dynamics processor on/off. This is the same as the dynamics 2 for INPUT
CH (➥ p.12).
Enables/disables the insert-in.

F SEL (Select)
9

Selects the MATRIX channel for which you want to make settings.

G CUE
This button cue-monitors the signal of the MATRIX channel.

H ON
This switches the MATRIX channel on/off.

I Fader
J

This adjusts the output level of the MATRIX channel. The current fader value is shown
in the numeric box immediately below the fader.
The numbers and alphabetical letters at the right of the fader indicate the mute groups
to which that channel belongs, and show the Recall Safe and Mute Safe status of the
channel. (For the significance of the numbers and alphabetical letters, see ➥ p.13).

J Channel number
Indicates the number of the MATRIX channel. You can double-click this number to
open the Selected Channel window for this channel. If you hold down the <Ctrl> key of
your computer keyboard and double-click this, the Selected Channel window will open
as an additional view.
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STEREO/MONO window

In this window you can view and edit the parameters of the STEREO and MONO channels. The parameters shown
in the window can be selected from the [View] menu or the menu that appears when you right-click in the window.
You can access this window in the following ways.
●
●

1
2
3
4

From the [Windows] menu, choose [Overview] and then choose “STEREO/MONO”
Use the navigation keys in the Master window to turn on the [STEREO] button

A EQ (Equalizer)
Switches the EQ on/off (the L/R settings are linked). This is the same as the equalizer for
INPUT CH (➥ p.12).

B DYN1(Dynamics 1)
Switches the dynamics processor on/off. This is the same as the dynamics 2 for INPUT
CH (➥ p.12).

C INS (Insert)
Enables/disables the insert-in. (The L/R settings are linked.)

D MATRIX SEND
Here you can view and edit the send levels of the signals sent from the STEREO/MONO
channel to MATRIX 1–8 bus. The method of operation and the meaning of the display
are the same as for MATRIX in the MIX window (➥ p.17).
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E BALANCE
Adjusts the left/right balance of the STEREO channel.

5
6
7
8

F SEL (Select)
Selects the channel for which you want to make settings. (You can specify L and R independently.) This is linked with the STEREO/MONO MASTER section [SEL] keys on
the M7CL’s panel.

G CUE
9

This button cue-monitors the signal of the STEREO/MONO channel. This is linked
with the STEREO/MONO MASTER section [CUE] keys on the M7CL’s panel.

H ON
This switches the STEREO/MONO channel on/off. This is linked with the STEREO/
MONO MASTER section [ON] keys on the M7CL’s panel.

J

I Fader
Adjusts the output level of the STEREO/MONO channel. This is linked with the STEREO/MONO MASTER section faders of the M7CL’s panel.
The current fader value is shown in the numeric box immediately below the fader.
The numbers and alphabetical letters at the right of the fader indicate the mute groups
to which that channel belongs, and show the Recall Safe and Mute Safe status of the
channel. (For the significance of the numbers and alphabetical letters, see ➥ p.15).

J Channel number
This is the channel number (ST or M). You can double-click this number to open the
Selected Channel window for this channel. If you hold down the <Ctrl> key of your
computer keyboard and double-click this, the Selected Channel window will open as an
additional view.
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DCA window

In this window you can view and edit the parameters of DCA groups 1–8.
You can access this window in the following ways.
●
●

1
2

From the [Windows] menu, choose [Overview] and then choose “DCA”
Use the navigation keys in the Master window to turn on the [DCA] button

A CUE
This button cue-monitors all channels that are assigned to the DCA group.

B ON
If you turn this on, all channels assigned to the DCA group will be turned on. If you
turn this off, no signal will be output from the channels assigned to the DCA group.

C DCA fader
3

4
5

This fader adjusts the level of the DCA group.
The current fader value is shown in the numeric box immediately below the fader.
You can set this to the minimum value (–∞ dB) by holding down the <Ctrl> key of
your computer keyboard and clicking the fader knob, or set it to the nominal value
(0.00 dB) by holding down the <Ctrl> key and <Shift> key and clicking the fader knob.
If the fader is at nominal level, the green indicator at the right of the fader will light.
If a DCA group is set to Recall Safe, the R character at the lower right of the fader is displayed in green.

D DCA number
This is the number of the DCA group.

E DCA group name
This is a text box that displays the DCA group name. You can also edit the DCA group
name in this text box.
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Selected Channel window
Here you can set the parameters of the currently selected input channel (INPUT CH 1–48 (*), ST IN channels 1–4) or
output channel (MIX channels 1–16, MATRIX channels 1–8, STEREO/MONO channels).
You can access this window in the following ways.
●
●
●

From the [Windows] menu, choose [Selected Channel] and select “MAIN VIEW”
Double-click the channel number in one of the Overview windows
On the M7CL itself, assign one of the USER DEFINED KEYS to [1-16]/[17-32]/[33-48](*) in [SEL CH] of [M7CL EDITOR CONTROL], and execute the function
NOTE

By choosing [Selected Channel] from the [Windows] menu and then selecting “ADDITIONAL VIEW,” you
can view a window for a channel that is not selected. This ADDITIONAL VIEW is not linked with [SEL] key
operations on the panel of the M7CL.

The type of parameters that can be edited in this window depends on the type of the currently selected channel. The
parameters of the Selected Channel window are explained below, in the order of input channels (input channels 1–
48, ST IN channels 1–4), MIX channels, MATRIX channels, and STEREO/MONO channels.
(*)

INPUT CH 33-48 can be viewed only if 48 is selected in the Input Channels field of the Mixer Setup window when editing offline, or
when editing online with the M7CL-48.

If an input channel is selected
● INPUT CH window
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● ST IN channel window

NOTE

Unless otherwise specified, the parameters explained below are common to INPUT CH 1–48 and ST IN
channels 1–4.

❏ CHANNEL SELECT (Channel selection)
1

2
3

A SELECT (Channel selection)
Indicates the number and name of the channel you are editing. To switch channels, use the SELECT button or the
triangle buttons at left and right. The channel selected in the Main View is linked with the [SEL] keys in the
INPUT section of the M7CL’s panel. You can right-click the icon and select the desired choice. You can also edit
the channel name in the text box.

B LIBRARY
Accesses the Input Channel Library. Click this button to open the INPUT CH page of the Library window.

C INPUT PATCH

Selects the input source assigned to the input channel (for the selectable input sources, ➥ p.11).
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❏ MIX/MATRIX SEND
2
1

3
A MIX send level
This adjusts the send level of the signal sent from the input channel to VARI-type MIX bus and MATRIX bus. The
current value is shown in the numerical box immediately below.

B PRE (Pre/Post)
This selects PRE or POST as the point from which the signal is sent from the input channel to the MIX bus and
MATRIX bus. The point will be PRE POINT when this is on, and POST FADER when this is off. The PRE POINT
setting can be specified in the Mixer Setup screen.

C ON (MIX send on/off)
This is an on/off switch for the signal sent from the input channel to the MIX bus and MATRIX bus.
HINT

• If MIX buses or MATRIX buses are being used in stereo, the
odd-numbered knob will be PAN.

Knob of odd-numbered side

Phace

• If the FIXED type is selected for the MIX bus, only the ON button is valid.

• The stereo/mono setting and the VARI type / FIXED type setting can be made in the Mixer Setup screen.

❏ HA GAIN/Ø/HPF
1

2

3

A HA (HA Gain)
Adjusts the gain of the internal head amp or of the external head amp (AD8HR) patched to the input channel.
The current value is shown in the numerical box below the knob. You can set this to the default value (+10 dB) by
holding down the <Ctrl> key and clicking the knob. You can also use the [48V] button to switch phantom power
on/off.

B Ø (Phase)
Inverts the phase of the signal after AD conversion.

C HPF (High Pass Filter)
Use the [ON] button at the right to switch the high-pass filter on/off. You can use the knob at left to adjust the
cutoff frequency. The current value is shown in the numerical box below the knob. An indication of “H” will
appear on the EQ graph of the equalizer.
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❏ TO STEREO/MONO
Here you can specify how the signal will be sent from the input channel to the STEREO bus / MONO bus.

MODE
• ST/MONO button
When this button is on, the signal will be sent to the STEREO L/R bus and independently to the MONO bus.

[INPUT CH 1–48]

[ST IN channel 1–4]

Adjusts the panning of the signal sent from the input channel to the STEREO bus L/R channels. You can set this to the center position by holding down the <Ctrl> key of the computer
PAN (BALANCE for ST IN)
keyboard and clicking the knob. This is linked with the [PAN] encoder in the SELECTED
CHANNEL section of the M7CL panel.
ST

Switches the signal sent from the input channel to the STEREO bus on/off.

M(C)

Switches the signal sent from the input channel to the MONO bus on/off.

• LCR button
When this button is on, the signal will be sent to the L/C/R buses which work in conjunction with each other.

[INPUT CH 1–48]

[ST IN channel 1–4]

Adjusts the panning of the signal that is sent from the input channel to each of the L/C/R
channels. You can set this to the center position by holding down the <Ctrl> key of the comPAN (BALANCE for ST IN)
puter keyboard and clicking the knob. This is linked with the [PAN] encoder in the
SELECTED CHANNEL section of the M7CL panel.
CSR (Center Side Ratio)

Adjusts the proportion of the CENTER channel level relative to the STEREO bus L/R in a
range of 0–100%.
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❏ EQUALIZER
1

2

3

5
6

4
7
8

9
K

J

A LIBRARY
Accesses the INPUT EQ page of the LIBRARY window.

B ON
Switches the EQ on/off.

C EQ graph
Indicates the response for the EQ of the currently selected channel. To reset the EQ to flat response, hold down
the <Ctrl> key of your computer keyboard and click the graph (The HPF setting will remain).

DQ
E FREQUENCY
F GAIN
These knobs adjust the Q, center frequency, and boost/cut amount for the four bands LOW, LO-MID, HI-MID,
and HIGH.

G

HIGH shelving
If this button is on, the HIGH EQ will be switched to a shelving type (the Q knob of the HIGH EQ will disappear).

H

LPF (Low Pass Filter)
If this button is on, the HIGH EQ will function as a low pass filter. The Q knob of the HIGH EQ will disappear,
and the GAIN knob will act as the low pass filter on/off switch.

I

LOW shelving
If this button is on, the LOW EQ will be switched to a shelving type (the Q knob of the LOW EQ will disappear).

J TYPE I/TYPE II (EQ type)
Selects either TYPE I (the algorithm used by previous digital mixers) or TYPE II (a newly developed algorithm) as
the EQ type.
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K ATT (Attenuation)
Adjusts the amount of attenuation/gain.

❏ DYNAMICS1/2
You can select one of the following types for each of the two dynamics processors.
DYNAMICS1:

GATE, DUCKING, EXPANDER, COMPRESSOR

DYNAMICS2:

COMPRESSOR, COMPANDER-H, COMPANDER-S, DE-ESSER

If GATE/DUCKING is selected
5

1

2

3
6
7
8

4
9
J

K

L

M

A TYPE
Indicates the type of the currently selected gate. You can click here to select the type.

B LIBRARY
This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the LIBRARY
window.

C ON
This button switches the gate on/off.

D Response curve
Indicates the response for the gate of the currently selected channel.

E GR meter
This meter indicates the amount of gain reduction.

F THRESHOLD (Threshold level)
Specifies the level at which the gate will open and close. The gate will open when the key-in signal exceeds this
level, and will close when the signal falls below this level.

G RANGE
Specifies the amount by which the signal is attenuated while the gate is closed.

H DECAY
Specifies the time over which the gate will close after the hold time has elapsed.

I ATTACK
Specifies the time from when the key-in signal exceeds the threshold level until the gate opens.
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J HOLD
Specifies the time that the gate will remain open after the key-in signal falls below the threshold.

K KEY IN SOURCE
Click this to select one of the following signals to use as the key-in source.
SELF PRE EQ
SELF POST EQ
MIX OUT 13–16
CH 1–48 POST EQ
STIN1L–STIN4R POST EQ

The pre-EQ signal of the currently selected input channel
The post-EQ signal of the currently selected input channel
The output signal of the corresponding MIX channel immediately before the output
attenuation
The post-EQ signal of the corresponding input channel (however, you can only choose
channels belonging to the same group, within the seven groups CH1–8, CH9–16,
CH17–24, CH25–32, CH33–40, CH41–48, and STIN1L–STIN4R).

L CUE
This button cue-monitors the currently selected key-in signal. This is not shown in the ADDITIONAL VIEW.

M KEY IN FILTER
Select the type of filter applied to the selected key-in signal; HPF (high pass filter), BPF (band pass filter), or LPF
(low pass filter). The ON/OFF button switches the filter on/off.
If you’ve selected BPF, use the two knobs to adjust the band pass frequency and Q. If you’ve selected HPF or LPF,
use the knob to adjust the cutoff frequency.

If COMPRESSOR is selected
5

1

2

3
6
7
8

4
9
J
K

L
A TYPE
Indicates the type of the currently selected compressor.

B LIBRARY
This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the LIBRARY
window.

C ON
This button switches the compressor on/off.

D Response curve
Indicates the response for the compressor of the currently selected channel.

E GR meter
This meter indicates the amount of gain reduction produced by the compressor.

F THRESHOLD
Specifies the threshold level at which the compressor will operate. The input signal will start being compressed
when the key-in signal exceeds this level; compression will be removed when the signal falls below this level.
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G RATIO
Specifies the ratio at which the input signal will be compressed when the key-in signal exceeds the threshold.

H KNEE
Specifies the sharpness at which the output level will change. You can select from HARD or 1–5.

I ATTACK
Specifies the time from when the key-in signal exceeds the threshold level until the signal starts being compressed.

J GAIN
Adjusts the gain of the signal after it has passed through the compressor.

K RELEASE
Specifies the time from when the key-in signal falls below the threshold level until compression is removed.

L KEY IN SOURCE
Click this to select the key-in signal that you want to use.
The choices are the same as for GATE.

If COMPANDER-H, COMPANDER-S is selected
5

1

2

3
6
7
8

4
9
J
K

L
A TYPE
Indicates the type of the currently selected compressor. You can click here to select the type.

B LIBRARY
This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the LIBRARY
window.

C ON
This button switches the compressor on/off.

D Response curve
Indicates the response for the compander of the currently selected channel.

E GR meter
This meter indicates the amount of gain reduction produced by the compressor.

F THRESHOLD
Specifies the threshold level at which the compressor will operate. The input signal will start being compressed
when the key-in signal exceeds this level; compression will be removed when the signal falls below this level.

G RATIO
Specifies the ratio at which the input signal will be compressed when the key-in signal exceeds the threshold.
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H WIDTH
Specifies the width between the threshold level of the compressor (THRESHOLD) and the threshold level of the
expander. The expander effect will apply to levels below THRESHOLD + WIDTH.

I ATTACK
Specifies the time from when the key-in signal exceeds the threshold level until the signal starts being compressed.

J GAIN
Adjusts the gain of the signal after it has passed through the compressor.

K RELEASE
Specifies the time from when the key-in signal falls below the threshold level until compression is removed.

L KEY IN SOURCE
Click this to select the key-in signal that you want to use.
The choices are the same as for GATE.

If DE-ESSER is selected
5

1

2

3

6
7
4

8
A TYPE
This indicates that De-Esser is the currently selected type.

B LIBRARY
This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the LIBRARY
window.

C ON
This button switches the de-esser on/off.

D Response curve
Indicates the response for the de-esser of the currently selected channel.

E GR meter
This meter indicates the amount of gain reduction produced by the de-esser.

F THRESHOLD
Specifies the threshold level at which the de-esser will operate. The input signal will start being compressed when
the key-in signal exceeds this level; compression will be removed when the signal falls below this level.

G FREQ. (Minimum frequency)
Specifies the minimum frequency at which the key-in signal will activate the de-esser.

H KEY IN SOURCE
Click this to select the key-in signal that you want to use.
The choices are the same as for GATE.
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❏ INSERT (except for ST IN channels)
1

2

3

4

A ON
Enables/disables insert-in/out.

B OUT (Insert out)
Click this to select the output port that will be assigned to insert-out, from the following choices.
NONE
SLOT1-1, SLOT1-2...SLOT3-15, SLOT3-16
RACK1A, RACK1B...RACK8R(B)

No assignment
Output channels of an I/O card installed in slots 1–3
L/R outputs of Rack 1–8

C IN (Insert in)
Click this to select the input port that will be assigned to insert-in, from the following choices.
NONE

No assignment

SLOT1-1, SLOT1-2...SLOT3-15, SLOT3-16
RACK1A, RACK1B...RACK8R(B)

Input channels of an I/O card installed in slots 1–3
L/R inputs of Rack 1–8

D POINT (Insert point)
Selects the position at which insert-in/out will be patched. Choose from PRE EQ, PRE FADER, or POST ON.

❏ DIRECT OUT (except for ST IN channels)
1

2

3

4

A ON
Turns the direct output on/off.

B DIRECT OUT GAIN
Adjusts the gain of the direct output. The current value is shown in the numerical box below the knob. You can set
this to the nominal value (0.0 dB) by holding down the <Ctrl> key and clicking the knob.

C DIRECT OUT PORT
Click this to select one of the following output ports as the one used for direct out.
NONE
OMNI1–OMNI16
SLOT1-1, SLOT1-2...SLOT3-16

No assignment
OMNI jacks 1–16
Output channels of an I/O card installed in slots 1–3

D DIRECT OUT POINT
Selects the position at which direct out will be patched. Choose from PRE HPF, PRE EQ, PRE FADER, or POST
ON.
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❏ RECALL SAFE/MUTE SAFE
These enable/disable Recall Safe and Mute Safe for the channel.

❏ DCA GROUP/MUTE GROUP
1

2

A DCA GROUP
Selects the DCA group (1–8) to which that channel belongs.

BMUTE GROUP
Selects the mute group (1–8) to which that channel belongs.

❏ Fader
1

A ON
Switches the input channel on/off. This is linked with the INPUT section CH [ON] keys
on the M7CL’s panel.

B Fader
2

Adjusts the input level of the input channel. This is linked with the INPUT section faders of the M7CL’s panel. A meter indicating the signal level is shown at the right of the
fader, and the current value is shown in the numerical box immediately below. You can
set this to the minimum value (–∞ dB) by holding down the <Ctrl> key of your computer keyboard and clicking the fader knob, or set it to the nominal value (0.00 dB) by
holding down the <Ctrl> key and <Shift> key and clicking the fader knob.

C CUE
3

This button cue-monitors the signal of the input channel. This is linked with the
INPUT section [CUE] keys on the M7CL’s panel.
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If a MIX channel is selected

❏ CHANNEL SELECT (Channel selection)
2

1

A SELECT (Channel selection)
Except for the fact that your editing applies to a MIX channel, this is
the same as the channel selection for an input channel (➥ p.24).

3 B LIBRARY
Accesses the Output Channel Library. Click this button to open the
OUTPUT CH page of the Library window.

C INPUT PATCH
Selects the input source assigned to the input channel (for the
selectable input sources, ➥ p.16)
If multiple patches have been made, only the first port is shown.
If you change the patching in this window, the port that had been
assigned until then will be cancelled, and only the newly selected
port will be assigned.

❏ TO MATRIX
A MATRIX send level
1
2
3

This adjusts the send level of the signal sent from the MIX channel to the MATRIX
buses.

B ON (MATRIX send on/off)
This is an on/off switch for the signal sent from the MIX channel to the MATRIX bus.

C POINT (Send point)
Select either PRE or POST as the position from which the signal is sent from the MIX
channel to the MATRIX bus. PRE POINT is selected if this is on, or POST FADER is
selected if this is off. The PRE POINT setting can be made in the Mixer Setup screen.
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HINT

Knob of oddnumbered side

• If you are using MATRIX buses in stereo, the knob for the odd-numbered bus will
be PAN.
• The stereo/mono status can be specified in the Mixer Setup screen.

❏ TO STEREO/MONO
Here you can specify how the signal will be sent from the MIX channel to the STEREO bus / MONO bus.

MODE
• ST/MONO button
When this button is on, the signal will be sent to the STEREO bus and independently to the MONO bus.

PAN

Adjusts the panning of the signal sent from the MIX channel to the STEREO bus L/R channels. You can set this to the center position by holding down the <Ctrl> key of the computer
keyboard and clicking the knob. This is linked with the [PAN] encoder in the SELECTED
CHANNEL section of the M7CL panel. If the selected MIX bus is used as a stereo bus, the
odd-numbered channel is fixed at L63 and the even-numbered channel fixed at R63.

ST

Switches the signal sent from the MIX channel to the STEREO bus on/off.

MONO

Switches the signal sent from the MIX channel to the MONO bus on/off.

BALANCE

This is shown only if the selected MIX bus is assigned as a stereo bus. It adjusts the left/
right volume balance of the stereo bus. You can set this to the center position by holding
down the <Ctrl> key of the computer keyboard and clicking the knob.

• LCR button
When this button is on, the signal will be sent to the L/C/R buses which work in conjunction with each other.

PAN

Adjusts the panning of the signal that is sent from the MIX channel to each of the L/C/R
channels. You can set this to the center position by holding down the <Ctrl> key of the computer keyboard and clicking the knob. This is linked with the [PAN] encoder in the
SELECTED CHANNEL section of the M7CL panel. If the selected MIX bus is used as a stereo bus, the odd-numbered channel is fixed at L63 and the even-numbered channel fixed at
R63.

BALANCE

This is shown only if the selected MIX bus is assigned as a stereo bus. It adjusts the left/
right volume balance of the stereo bus. You can set this to the center position by holding
down the <Ctrl> key of the computer keyboard and clicking the knob.

CSR (Center Side Ratio)

Adjusts the proportion of the CENTER channel level relative to the STEREO bus L/R in a
range of 0–100%.
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❏ EQUALIZER
1

2

3

4
5

6
7
8

9
J
K

L

A LIBRARY
Accesses the OUTPUT EQ page of the LIBRARY window.

B ON
Switches the EQ on/off.

C EQ graph
Indicates the response for the EQ of the currently selected channel. To reset the EQ to flat response, hold down
the <Ctrl> key of your computer keyboard and click the graph.

DQ
E FREQUENCY
F GAIN
These knobs adjust the Q, center frequency, and boost/cut amount for the four bands LOW, LO-MID, HI-MID,
and HIGH.

G

HIGH shelving
If this button is on, the HIGH EQ will be switched to a shelving type (the Q knob of the HIGH EQ will disappear).

H

LPF (Low Pass Filter)
If this button is on, the HIGH EQ will function as a low pass filter. The Q knob of the HIGH EQ will disappear,
and the GAIN knob will act as the low pass filter on/off switch.

I

(LOW shelving)
If this button is on, the LOW EQ will be switched to a shelving type (the Q knob of the LOW EQ will disappear).

J

HPF (High Pass Filter)
If this button is on, the LOW EQ will function as a high pass filter EQ. The Q knob of the LOW EQ will disappear,
and the GAIN knob will act as the high pass filter on/off switch.

K TYPE I/TYPE II (EQ type)
Selects either TYPE I (the algorithm used by previous digital mixers) or TYPE II (a newly developed algorithm) as
the EQ type.

L ATT (Attenuation)
Adjusts the amount of attenuation/gain.
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❏ DYNAMICS1
Except for the fact that the available types are COMPRESSOR, EXPANDER, COMPAND H and COMPAND S,
and that you can select more than one signal as the key-in signal, this is the same as the dynamics for input channels (➥ p.28).

❏ INSERT
Except for the fact that the insert points that can be selected are different, this is the same as for the insert settings
of an input channel (➥ p.32).

❏ RECALL SAFE/MUTE SAFE
These are the same as the Recall Safe and Mute Safe functions for input channels.

❏ MUTE GROUP
Selects the mute group (1–8) to which the MIX channel belongs.

❏ Pan/Fader
A ON
1

Switches the MIX channel on/off.

B Fader
2

Adjusts the output level of the MIX channel. A meter indicating the signal level is
shown at the right of the fader, and the current value is shown in the numerical box
immediately below. You can set this to the minimum value (–∞ dB) by holding down
the <Ctrl> key of your computer keyboard and clicking the fader knob, or set it to the
nominal value (0.00 dB) by holding down the <Ctrl> key and <Shift> key and clicking
the fader knob.

C CUE
This button cue-monitors the signal of the MIX channel.

3
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If a MATRIX channel is selected

❏ CHANNEL SELECT (Channel selection)
Except for the fact that your editing applies to a MATRIX channel, this is the same as the channel selection for a
MIX channel (➥ p.34).

❏ FROM MIX, ST/MONO
A FROM MIX, ST/MONO send level
These adjust the send levels of the signals sent from the VARI type MIX buses or STEREO/MONO buses to the
MATRIX bus. The current value is shown in the numerical box immediately below.

• PRE/POST
These select either PRE or POST as the position from which the signal is sent from the MIX buses or STEREO/
MONO buses to the MATRIX bus. PRE POINT is selected if this is on, or POST FADER is selected if this is off.

B ON(FROM MIX, ST/MONO send on/off)
These are on/off switches for the signal sent from the MIX buses or STEREO/MONO buses to the MATRIX bus.
HINT

• If MIX buses and MATRIX buses are being used in stereo, the
odd-numbered knob will be PAN.

PAN (odd-numbered side)

• If the FIXED type is selected for the MIX bus, only the ON button is valid.

• The stereo/mono setting and the VARI type / FIXED type setting can be made in the Mixer Setup screen.
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❏ BALANCE

This is shown only if the selected MATRIX bus is being used as stereo. It adjusts the left/right volume balance of
the stereo signal. You can set this to the center value by holding down the <Ctrl> key of your computer keyboard
and clicking this knob.

❏ EQUALIZER
This is the same as for the equalizer of a MIX channel (➥ p.36).

❏ DYNAMICS1
Except for the fact that the available types are COMPRESSOR, EXPANDER, COMPAND H and COMPAND S,
and that you can select more than one signal as the key-in signal, this is the same as the dynamics for input channels (➥ p.28).

❏ INSERT
Except for the fact that the insert points that can be selected are different, this is the same as for the insert settings
of an input channel (➥ p.32).

❏ RECALL SAFE/MUTE SAFE
These are the same as the RECALL SAFE/MUTE SAFE of a MIX channel (➥ p.37).

❏ MUTE GROUP
These are the same as the MUTE GROUP of a MIX channel (➥ p.37).

❏ Fader
1

A ON
This switches the MATRIX channel on/off.

B Fader
2

This adjusts the output level of the MATRIX channel. A meter indicating the signal level
is shown at the right of the fader, and the current value is shown in the numerical box
immediately below. You can set this to the minimum value (–∞ dB) by holding down
the <Ctrl> key of your computer keyboard and clicking the fader knob, or set it to the
nominal value (0.00 dB) by holding down the <Ctrl> key and <Shift> key and clicking
the fader knob.

C CUE
This button cue-monitors the signal of the MATRIX channel.

3
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If a STEREO/MONO channel is selected
● STEREO channel window

● MONO channel window

❏ CHANNEL SELECT (Channel selection)
Except for the fact that your editing applies to a STEREO/MONO channel, this is the same as the channel selection for a MIX channel (➥ p.34).

❏ TO MATRIX
These are the same as the TO MATRIX of a MIX channel (➥ p.34).
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❏ BALANCE (except for MONO channel)

This adjusts the left/right volume balance in the STEREO bus. You can set this to the center value by holding
down the <Ctrl> key of your computer keyboard and clicking this knob.

❏ EQUALIZER
This is the same as the equalizer settings of a MIX channel (➥ p.36).

❏ DYNAMICS1
Except for the fact that the available types are COMPRESSOR, EXPANDER, COMPAND H and COMPAND S,
and that you can select more than one signal as the key-in signal, this is the same as the dynamics for input channels (➥ p.28).

❏ INSERT
Except for the fact that the insert points that can be selected are different, this is the same as for the insert settings
of an input channel (➥ p.32).

❏ RECALL SAFE/MUTE SAFE
These are the same as the RECALL SAFE/MUTE SAFE of a MIX channel (➥ p.37).

❏ MUTE GROUP
These are the same as the MUTE GROUP of a MIX channel (➥ p.37).

❏ Fader
STEREO

1

2

MONO

1

2

A ON
This switches the STEREO/MONO channel on/off. This is
linked with the STEREO/MONO MASTER section [ON]
keys on the M7CL’s panel.

B Fader
Adjusts the output level of the STEREO/MONO channel.
This is linked with the STEREO/MONO MASTER section
faders of the M7CL’s panel. A meter indicating the signal level
is shown at the right of the fader, and the current value is
shown in the numerical box immediately below.

CCUE

3

3

This button cue-monitors the signal of the STEREO/MONO
channel. This is linked with the STEREO/MONO MASTER
section [CUE] keys on the M7CL’s panel.
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Library window

Here you can edit the M7CL’s various libraries. You can also load library files that were saved on a drive of your computer, edit the order or title of library items, recall the desired library data, or copy desired library data to a library
within the M7CL.
This window is divided into DYNAMICS, INPUT EQ, OUTPUT EQ, EFFECT, GEQ, INPUT CH, and OUTPUT CH
pages; to switch pages, click the tabs located at the top of the window.
To display this window, choose [LIBRARY] from the [Windows] menu, and select either “DYNAMICS,” “INPUT
EQ,” “OUTPUT EQ,” “EFFECT,” “GEQ,” “INPUT CH,” or “OUTPUT CH.”

1

2

3

4

5
A OPEN (Open a file)
Opens a library file located on a drive of your computer. Use this when you want to edit library data that you’ve
saved on a USB storage device.

B CLOSE (Close a file)
Closes the currently-open library file.

C SAVE
Saves the currently-open library file on a drive of your computer. Use this to re-save an edited library on a USB
storage device, or to create a backup on the hard disk of your computer.

D SAVE AS (Save under a different name)
Saves the currently-open library file under a different name on a drive of your computer.

E File name
Indicates the file name of the currently-open library.
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7

8

J

L

(Effect/GEQ page only)

K

(DYNAMICS page only)

9

M
6

N
O
P
Q

F FILE
This list shows the contents of the data in the library file you opened using the OPEN button ( 1). The list
includes the following items.

G No. (Number)
This column indicates the number of each item in the library.

H TITLE
This column indicates the title assigned to each library item. You can also double-click this area and edit the title.

I READ ONLY
Read-only data is indicated by an “R” in this column. It cannot be overwritten, nor can its title be edited.

J TYPE
This column indicates the effect type.
In the case of dynamics, there is also an indication of the dynamics processor(s) of this channel into which each
library item can be recalled. Only library items with an indication of “1” can be recalled to DYNAMICS 1, and
only library items with an indication of “2” can be recalled to DYNAMICS 2. Library items with neither of these
indications cannot be recalled to this channel.

K DYNAMICS (DYNAMICS page only)
Select which of the two dynamics processors will be subject to the Store or Recall operation.

L RACK No. (Rack selection) (Effect/GEQ page only)
Select which rack will be subject to the Store or Recall operation.
NOTE

HQ Pitch and Freeze cannot be recalled to an effect module mounted in Rack 6 or Rack 8.

M INTERNAL DATA
This area shows the M7CL’s scene memory contents. The items displayed are the same as in the FILE list ( 6).
As desired, you can copy single or multiple scenes between the FILE list and the INTERNAL DATA list, and copy
or move them to a different location within a list.
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To do this, use the following methods to select the scene(s) that you want to copy or move.

• To select a single scene
Click the line containing the desired scene.

• To select multiple consecutive scenes
Click the first scene to select it; then hold down the <Shift> key and
click the last scene.

• To select multiple non-consecutive scenes
Click the first scene; then hold down the <Ctrl> key and click each of
the remaining scenes.

When you have selected the scene(s) that you want to move or copy, drag them to the desired location in the other
list (if you’re copying between lists) or in the same list (if you’re copying/moving within the same list).

• To copy scenes (overwriting the destination)
Drag the copy-source scene(s) to the desired line in the other list or to
another line in the same list. At this time, a ® symbol will appear at
the right of the scene number.
When you drop the scene in this state, a dialog box will appear, asking
you to confirm the Save operation. If you click the OK button, the
copy-source scene(s) will be overwritten onto the copy-destination
scenes, and the copy-source scene(s) will remain unchanged. (If the
copy-source selection contains multiple scenes, the data will be overwritten onto consecutive scenes starting at that scene.)

• To move scenes
Within the same list, you can move the selected scene(s) to another
location to rearrange the order of the scenes in the list. To do this,
drag the selected scene(s) to a location between two other lines in the
same list. At this time, a
symbol will appear between the lines.
When you release the mouse button in this state, the selected scene(s)
will move to that location, and the scene numbers will also change
accordingly. (If the move-source selection contains multiple scenes,
those scenes will be inserted consecutively at the location you specify.)
NOTE

You cannot copy the InitialData of the GEQ library.

N STORE
Stores the current settings to the data item that is selected in the list.

O RECALL
Recalls the data item that is selected in the list.

P CLEAR
Clears the data item(s) selected in the list. (The title of the cleared item(s) will be reset to [No Data!].)

Q UNDO
Cancels the last-performed library recall, store, copy, or move operation.
You can click this repeatedly to repeat Undo and Redo.
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Patch Editor window
Here you can assign the input/output port for each channel, its direct output, and its insert-in/out.
This window is divided into INPUT PATCH, OUTPUT PATCH, INPUT INSERT PATCH, OUTPUT INSERT PATCH,
DIRECT OUT PATCH, and PATCH LIST pages. To switch pages, click the tabs shown in the upper part of the window.
To display this window, choose [PATCH Editor] from the [Windows] menu, and select either “INPUT PATCH,”
“OUTPUT PATCH,” “INPUT INSERT PATCH,” “OUTPUT INSERT PATCH,” “DIRECT OUT PATCH,” or “PATCH
LIST.”

INPUT PATCH page

Here you can select the input port that is assigned to the input of each input channel.

❏ PRESET
Initializes the patching in this page.

❏ CLEAR ALL
Clears all patching in this page.
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OUTPUT PATCH page

Here you can select the input port that is assigned to the output of each output channel.

INPUT INSERT PATCH page

Output port selection

Input port selection

Here you can assign input/output ports to the insert-in/out of each input channel. Select the output port in the left
side of the screen, and the input port in the right side of the screen.
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OUTPUT INSERT PATCH page

Output port selection

Input port selection

Here you can assign input/output ports to the insert-in/out of each output channel. Select the output port in the left
side of the screen, and the input port in the right side of the screen.

DIRECT OUTPUT PATCH page

Here you can select the output port that will directly output each input channel.
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PATCH LIST page

Here you can view and edit the input patch and output patch settings.

1 2

3

4

5

6

A Input channel number
B Input channel name
This is the number and name of the input channel. You can click the channel name box to edit the name in this
page.

C Input port
This shows the input port assigned to the input channel. You can click this box and choose the input port from
the popup menu that appears.

D Output channel number
E Output channel name
This is the number and name of the output channel. You can click the channel name box to edit the name in this
page.

F Output port
This shows the output port assigned to the output channel. You can click this box and choose the output port
from the popup menu that appears.
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Rack window

Here you can make settings for GEQ, effects, and external head amps.
This window is divided into GEQ/EFFECT and EXTERNAL HA pages; to switch pages, click the tabs located at the
top of the window.

GEQ/EFFECT page
1

2

3

4

5

6
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A Mount
Select a GEQ module or effect module for mounting in the rack, from the following choices.
BLANK

No assignment

31 Band GEQ

31-band 1-in/1-out graphic equalizer

Flex15GEQ

2-in/2-out graphic equalizer that allows any fifteen of the 31
bands to be controlled

EFFECT

Internal effect (only for RACK 5–8)

B Input patch
Select the input port(s) that will be assigned to the rack, from the following choices.
NONE

No assignment

MIX 1–16

MIX channel 1–16

MATRIX1-– 8

MATRIX channel 1–8

ST L, ST R, MONO(C)

STEREO channel L/R, MONO channel

INS CH 1–48(*)

INPUT CH 1–48(*) insert in

INS MIX 1–16

MIX channel 1–16 insert in

INS MATRIX1–8

MATRIX channel 1–8 insert in

INS ST L, INS ST R, INS
MONO(C)

Insert-in of STEREO channel L/R or the MONO channel

(*)

INPUT CH 33-48 can be viewed only if 48 is selected in the Input Channels field of the Mixer Setup window when editing offline, or
when editing online with the M7CL-48.

This is not shown if nothing is mounted in the rack.

C Module graphic
This area shows a graphic of the GEQ module or effect module that is currently assigned to the rack, and the
parameters of that module. You cannot edit the parameters in this screen.
Double-click this to open the module editor for that rack unit.
By holding down the <Ctrl> key of your computer keyboard and double-clicking this, you can open multiple
rack module editors. For these additional editors, the rack select buttons are not linked with the RACK popup
window of the M7CL itself.

D Input meter/Output meter
These indicate the level of the signals being input and output from the rack.

E Output patch
Select the output port(s) that will be assigned to the rack, from the following choices.
NONE

No assignment

CH 1–48(*)

INPUT CH 1–48(*)

STIN1L-STIN4R

ST IN channel 1–4 (L/R)

INS CH 1–48(*)

INPUT CH 1–48(*) insert out

INS MIX 1–16

MIX channel 1–16 insert out

INS MTRX1–INS MTRX8

MATRIX channel 1–8 insert out

INS ST L, INS ST R, INS
MONO(C)

Insert-out of STEREO channel L/R or the MONO channel

(*)

INPUT CH 33-48 can be viewed only if 48 is selected in the Input Channels field of the Mixer Setup window when editing offline, or
when editing online with the M7CL-48.

F ON, BYPASS
This switches the GEQ module or effect module between active and bypassed states.
A GEQ module is active when the ON button is lit.
An effect module is active when the BYPASS button is dark.
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Rack module editor — GEQ window
● 31 Band GEQ

● Flex15GEQ

In this window you can select the insertion destination of GEQ, and edit the parameters.

ARack No. (Rack selection)
1

Select the rack module that you want to control.

BLIBRARY
2

This button accesses the GEQ library. Clicking this button
will open the GEQ page of the LIBRARY window.
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3

4

CInput patch
Click the CHANNEL field, and choose one of the following as the signal route that will
be patched to the input channel(s) of the currently selected GEQ module.
NONE

No assignment

MIX 1–16

MIX channel 1–16

MATRIX1-– 8

MATRIX channel 1–8

ST L, ST R, MONO(C)

STEREO channel L/R, MONO channel

INS CH 1–48(*)

INPUT CH 1–48(*) insert in

INS MIX 1–16

MIX channel 1–16 insert in

INS MATRIX1–8

MATRIX channel 1–8 insert in

INS ST L, INS ST R, INS MONO(C) Insert-in of STEREO channel L/R or the MONO channel
(*)

INPUT CH 33-48 can be viewed only if 48 is selected in the Input Channels field of the Mixer Setup
window when editing offline, or when editing online with the M7CL-48.

The channel name is shown in the boxes immediately below.

D Input meter
This indicates the level of the signal that is being input to the currently selected GEQ
module.

E Output patch
5

6

Click the CHANNEL field, and choose one of the following as the signal route that will
be patched to the output channel(s) of the currently selected GEQ module.
NONE

No assignment

CH 1–48(*)

INPUT CH 1–48(*)

STIN1L-STIN4R

ST IN channel 1–4 (L/R)

INS CH 1–48(*)

INPUT CH 1–48(*) insert out

INS MIX 1–16

MIX channel 1–16 insert out

MATRIX INSERT1–8

MATRIX channel 1–8 insert out

INS ST L, INS ST R, INS MONO(C) Insert-out of STEREO channel L/R or the MONO channel
(*)

INPUT CH 33-48 can be viewed only if 48 is selected in the Input Channels field of the Mixer Setup
window when editing offline, or when editing online with the M7CL-48.

The channel name is shown in the boxes immediately below.

F Output meter
This indicates the level of the signal that is being output to the currently selected GEQ
module.
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● 31 Band GEQ

8

9

7
J
K

● Flex15GEQ

8
L
7
J
K

G ON (GEQ on/off)
Switches the currently selected GEQ module on/off.

H LINK
This button links the settings of two adjacent odd-numbered/even-numbered 31-band GEQ modules, or the
group A and group B settings of a Flex 15 GEQ. When you click this button, a window will ask you for confirmation. Click the buttons for the modules you want to use as the parameter copy-source and copy-destination. If
you click the RESET BOTH button, the parameters of both modules will be reset to the default state.

I GEQ graph
This graph shows the response of the currently selected GEQ module.

J GEQ faders
These faders cut/boost the frequency bands of the GEQ module. The value of each fader is shown in the numerical box below it. Hold down the <Ctrl> key and click to set the value to 0.00 dB.

K EQ FLAT
This button resets all GEQ faders to the 0 dB position.

L AVAILABLE BANDS (number of operable bands) (Flex 15 GEQ only
For a Flex 15 GEQ, you can operate any fifteen of the thirty-one bands. This numerical display box shows the
remaining number of bands that can be operated. If you have operated fifteen bands, this number will be zero,
and you won’t be able to operate any additional bands. If you want to operate another band in this state, you’ll
need to return a previously-operated band back to the 0 dB position.
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Rack module editor — Effect window

Here you can select the effect type for an internal effect, edit the parameters, and specify the input/output patching.
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1

2

ARack No. (Rack selection)

3

Select the rack module that you want to control.

B BYPASS
This button temporarily bypasses the effect.

C CUE
This button cue-monitors the output of the currently selected
effect.

6

4 5

D EFFECT NAME
Indicates the title of the currently selected effect.

E EFFECT TYPE
Indicates the currently selected effect type. You can also switch the effect type from this window. To do so, click
the text box, and select the desired effect type from the popup menu that appears.

F LIBRARY
This button accesses the effect library. Clicking this button will open the EFFECT page of the LIBRARY window.

GInput patch
Click the L CHANNEL or R CHANNEL area, and choose one of the
following as the signal route that will be patched to the L/R input channels of the internal effect.

8
7

J
9

NONE

No assignment

MIX 1–16

MIX channel 1–16

MATRIX1–8

MATRIX channel 1–8

ST L, ST R, MONO(C)

STEREO channel L/R, MONO channel

INS CH 1–48(*)

INPUT CH 1–48(*) insert in

INS MIX 1–16

MIX channel 1–16 insert in

INS MATRIX1–8

MATRIX channel 1–8 insert in

INS ST L, INS ST R, INS
MONO(C)

Insert-in of STEREO channel L/R or the MONO
channel

(*)

K

INPUT CH 33-48 can be viewed only if 48 is selected in the Input Channels field of
the Mixer Setup window when editing offline, or when editing online with the
M7CL-48.

The channel name is shown in the boxes immediately below.

H Input meter
Indicates the level of the signal being input to the internal effect.

I Output patch
Click the L CHANNEL or R CHANNEL area, and choose one of the following as the signal route that will be
patched to the L/R output channels of the internal effect.
NONE

No assignment

CH 1–48

INPUT CH 1–48(*)

STIN1L–STIN4R

ST IN channel 1–4 (L/R)

INS CH 1–48(*)

INPUT CH 1–48(*) insert out

INS MIX 1–16

MIX channel 1–16 insert out

MATRIX INSERT1–8

MATRIX channel 1–8 insert out

INS ST L, INS ST R, INS MONO(C)

Insert-out of STEREO channel L/R or the MONO channel

(*)

INPUT CH 33-48 can be viewed only if 48 is selected in the Input Channels field of the Mixer Setup window when editing offline, or
when editing online with the M7CL-48.

The channel name is shown in the boxes immediately below.

55

M7CL V2 Editor Owner’s Manual

J Output meter
Indicates the level of the signal being output from the internal effect.

K Parameter display select button
If “046 REV-X Hall,” “047 REV-X ROOM,” or “048 REV-X PLATE” is selected as the effect type, this button
switches between the standard parameter screen and a dedicated GUI screen.

L MIX BALANCE
Adjusts the balance of the effect sound relative to the original sound. 0 (%) outputs
only the original sound, and 100 (%) outputs only the effect sound.

L

M TEMPO
If a tempo-type or modulation-type effect is selected, this allows you to adjust timerelated parameters such as DELAY (delay time) and FREQ. (modulation speed).
To set the value of the TEMPO parameter, you can either input the BPM (Beats Per
Minute) in the numerical box, or repeatedly click the TAP TEMPO button at the
desired tempo.
If the MIDI CLK button is on, the TEMPO parameter value will synchronize to the
MIDI timing clock being received from the MIDI port.

M

N SOLO
If “044 M.BAND DYNA” or “045 M.BAND COMP” are selected as the effect type, these
buttons allow you to monitor only the specified band from the three bands HIGH,
MID, and LOW.

N

OGR meter
If “044 M.BAND DYNA” or “045 M.BAND COMP” are selected as the effect type, this
indicates the gain reduction amount for the H (HIGH), M (MID), and L (LOW) bands.

O

P

Q

P PLAY/REC (Play/Record) buttons
If “042 FREEZE” is selected as the effect type, you can use these buttons to record and play back the signal being
input to the effect.

Q Effect parameters
This area shows the effect parameters and knobs for the currently selected effect type.
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EXTERNAL HA page

1

2 34

5

6

A External HA name
This shows the model name and ID number of the currently connected external head amp device.

B GAIN
This specifies the gain for each channel. The current value is shown in the box below.

C 48V
This switches the phantom power (+48V) on/off for each channel.

D HPF (High Pass Filter)
This switches the HPF on/off for each channel.

E +48V MASTER
If an AD8HR is connected, this indicates the on/off status of the master phantom power supply.

F Slots/Channels
Here you can select the slots/channels to which the audio outputs of the external head amp device are connected.
NONE
SLOT1 1-8
SLOT1 9-16
SLOT2 1-8
SLOT2 9-16
SLOT3 1-8
SLOT3 9-16
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Meter window
This window shows the signal levels of each section in the M7CL, letting you check for the presence of signals and
whether an overload is occurring.
This window is divided into INPUT METER and OUTPUT METER; to switch pages, click the tabs located at the top
of the window.
NOTE

In order to view the M7CL’s signal levels in the Meter window, make sure that M7CL Editor and the M7CL
itself are synchronized.

INPUT METER page
1

2

3

A METERING POINT
Select one of the following as the point where metering will occur.
PRE HPF, PRE FADER, POST ON

B PEAK HOLD
Switches peak hold on/off.

C Meters
These peak level meters show the input level of each channel. The current fader value is shown in the box below.
If clipping occurs at any one of the detection points in the channel, the ∑ segment will light.
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OUTPUT METER page
1

2

3

A METERING POINT
Select one of the following as the point where metering will occur.
PRE EQ, PRE FADER, POST ON

B PEAK HOLD
This is the same as in the INPUT METER page.

C Meters
This is the same as in the INPUT METER page.
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Group/Link window
In this window you can select the channels that will be assigned to each DCA group and mute group. This window is
divided into three pages; the DCA GROUP ASSIGN page, the MUTE GROUP ASSIGN page and CHANNEL LINK
page.

DCA GROUP ASSIGN page

Here you can specify the channels that will be assigned to DCA groups 1–8.

1

2

3

4

A DCA group
This is the number of the DCA group.

B DCA group name
This is the name of the DCA group. You can also click the mouse on this area to edit the name.

C Grid
This grid lets you assign channels (horizontal rows) to DCA groups (vertical columns). Currently-patched grids
are indicated by a symbol. To enable or disable an assignment, click the desired grid.

D CLEAR
These buttons clear all channels assigned to the corresponding DCA group. When you click one of these buttons a
window will appear, asking you to confirm the operation. To execute the Clear operation, click the OK button.
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MUTE GROUP ASSIGN page

Here you can specify the channels that will be assigned to mute groups 1–8. The upper part of the screen lets you
assign input channels to mute groups, and the lower part of the screen lets you assign output channels to mute
groups.

12

3

4

5

A Mute group
This area shows the mute group number.

B MUTE MASTER
These buttons enable/disable each input channel or output channel mute group.

C Grid
This grid lets you assign channels (horizontal rows) to mute groups (vertical columns). Currently-patched grids
are indicated by a symbol. To enable or disable an assignment, click the desired grid.

D MUTE SAFE ON
These buttons switch Mute Safe on/off for each channel. Channels for which this button is on will be excluded
from mute groups.

E CLEAR
These buttons clear all input channels and output channels assigned to the corresponding mute group. When you
click one of these buttons a window will appear, asking you to confirm the operation. To execute the Clear operation, click the OK button.

61

M7CL V2 Editor Owner’s Manual

CHANNEL LINK page

If you link two or more input channels, the parameters of these channels will interlock with each other and change
simultaneously.

1

2
3

4

A Link buttons
Use these buttons to select the link group A–Z (*) to which you want each input channel to be assigned. If you
don’t want an input channel to be linked, select NONE. You can assign up to twenty-four (*) groups for INPUT
CH 1–48, and up to two groups for ST IN channels.
(*)

During offline editing when 32 is selected in the Input Channels field of the Mixer Setup window, or during online editing with the
M7CL-32 connected, up to sixteen groups can be assigned for INPUT CH 1–32, and you’ll be able to choose from link groups A–R.

B CLEAR ALL
Clears the link settings for all channels.
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C LINK PARAMETER
This section enables you to select the parameters to interlock.
HA

Head amp gain and phantom power settings

DYNAMICS1

Dynamics 1 settings

DYNAMICS2

Dynamics 2 settings

EQ

Equalizer settings

MIX ON

MIX SEND on/off

MIX SEND

Send amount from input channel to MIX bus

MATRIX ON

MATRIX SEND on/off

MATRIX SEND

Send amount from input channel to MATRIX bus

FADER

Fader level value

CH ON

Input channel module output on/off

(*)

INPUT CH 33-48 can be viewed only if 48 is selected in the Input Channels field of the Mixer Setup window when editing offline, or
when editing online with the M7CL-48.

NOTE The HA and FADER parameters will maintain level differences between linked channels.

D SEND PARAMETER
Specify the link status for each MIX/MATRIX SEND bus.
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Scene window
Here you can manage scene memories, and make various settings related to scene recall operations.
This window is divided into SCENE MEMORY, RECALL SAFE, and FADE TIME pages. To switch pages, click the
tabs shown in the upper part of the window.

SCENE MEMORY page

Here you can edit the M7CL’s scene memories. You can also load scene library files from a USB storage device or
from a drive of your computer, and edit them. In this case, you can re-save all scenes to a file after editing, recall just
a desired scene, or copy a desired scene to the scene memory of the M7CL itself.

1

2

3

4

5

A File name
Indicates the file name of the currently-open
scene library.

B OPEN (Open a file)
Opens a scene library file located on a drive of
your computer.

C CLOSE (Close a file)
Closes the currently-open scene library file.

D SAVE
Saves the currently-open scene library file on a
drive of your computer.

6

E SAVE AS (Save as a different
name)
Saves the currently-open scene library file under
a different name on a drive of your computer.
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F FILE
This area lists the scenes in the file you opened using the OPEN button ( 2). The list includes the following items.
HINT

To view items that are not currently shown, scroll the list to the right.

7

8

9

J

K

L

M

G No.
This is the scene number.

H TITLE
This is the scene title. You can also double-click this area and edit the title.

I PROTECT
This indicates whether protect is on or off for each scene. This area displays a lock icon for protected scenes; these
scenes cannot be overwritten, nor their title edited. Read-only scenes are indicated by “R” displayed in this column.

J COMMENT
This column shows the comment assigned to each scene. You can also double-click this column and edit the comment.

K FOCUS
From the following list, choose the parameters that will be recalled by a Scene Recall. If you select ALL, the other
buttons will be unavailable. Multiple selections are allowed for buttons other than ALL.
ALL
RACK
HA
IN PATCH
OUT PATCH

OUT

All the settings of the scene will be recalled
GEQ and internal effect settings will be recalled
Internal head amp and external head amp settings will be recalled
Input patch settings will be recalled
Output patch settings will be recalled
Input channels (INPUT, ST IN, DCA) settings will be recalled except for head
amp settings
Output channel (MIX, MATRIX, STEREO/MONO) settings will be recalled

WITH SEND(*)

Send settings to the output channels will be recalled

IN

(*) Can be selected only if

OUT is selected

L TIME STAMP
Indicates the time at which the scene was last stored, in the format of month/day/year/hours/minutes/seconds.
This column is only for display, and cannot be edited.

M FADING
This switches fading on/off for each scene.
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N
O
P
Q
R
S

N INTERNAL DATA
This area shows the M7CL’s scene memory contents. The items displayed are the same as in the FILE list ( 6).
As desired, you can copy single or multiple scenes between the FILE list and the INTERNAL DATA list, and copy
or move them to a different location within a list.

O STORE
Stores the current settings to the scene that is selected in the list.

P RECALL
Recalls the settings of the scene selected in the list.

Q CLEAR
Clears the scene(s) selected in the list. (The title of the cleared scene(s) will be reset to [No Data!].)

R UNDO
Cancels the last-performed scene recall, store, copy, or move operation.

S PROTECT
Turns on the Protect setting for the scene(s) selected in the list.
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RECALL SAFE page

Here you can make settings for the Recall Safe function that excludes only specific channels from recall operations of
all scenes.

1

2

3

A INPUT SAFE PARAMETERS
In this area you can view and edit the Recall Safe settings for all
input channels and ST IN channels. This area contains the following
items.

B SAFE ON/OFF
These are on/off buttons that select the channels to be excluded
from recall operations.

C Parameter matrix grid
Here you can select the parameters to be excluded from recall operations. If the ALL button is on, all parameters will be excluded.

D SET ALL
These buttons turn on all buttons for all input channels or ST IN
channels, or for the corresponding parameter.

E CLEAR ALL
These buttons turn off all buttons for all input channels or ST IN
channels, or for the corresponding parameter.

5 4
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6

7

8
9
J
K
L

M

N
O
F OUTPUT SAFE PARAMETERS
In this area you can view and edit the Recall Safe settings for all output channels. The items in this area are the
same as in the Input Safe Parameters area (1).

G GLOBAL RECALL SAFE
In this area you can view and edit the Recall Safe settings for patching, DCA groups, and racks.

H INPUT PATCH
This on/off button specifies whether INPUT PATCH settings will be excluded from recall operations.

I INPUT NAME
This on/off button specifies whether the channel names of input channels will be excluded from recall operations.

J OUTPUT NAME
This on/off button specifies whether the channel names of output channels will be excluded from recall operations.

K OUTPUT PATCH
This on/off button specifies whether OUTPUT PATCH settings will be excluded from recall operations.

L DCA
These buttons exclude DCA groups from recall operations. If the ALL button is on, the LEVEL, ON, and DCA
group names will be excluded. If the LEVEL/ON button is on, LEVEL and ON settings will be excluded.

M RACK
This on/off button specifies whether RACK settings will be excluded from recall operations.

N SET ALL
This button switches on all buttons for parameters 8–13.

O CLEAR ALL
This button switches off all buttons for parameters 8–13.
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FADE TIME page

1

2

3

Here you can make settings for the Fade Time function which adjusts the time over which fader and pan will reach
their new values when a scene is recalled. Since the Fade function settings are independent for each scene, you must
recall the desired scene before you make these settings.

A INPUT CHANNEL FADING ENABLE
These on/off buttons select the input channels that will be excluded from recall operations.

B SET ALL
This button switches on the buttons of all input channels.

C CLEAR ALL
This button switches off the buttons of all input channels.
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4

5
6

7

8

D OUTPUT CHANNEL FADING ENABLE
These are on/off buttons that select the output channels that will be excluded from recall operations.

E SET ALL
This button switches on the buttons of all output channels.

F CLEAR ALL
This button switches off the buttons of all output channels.

G FADING ENABLE
This button enables/disables the Fade function for the faders of the current scene.

H FADE TIME
Drag this knob in the screen to adjust the fade time. The current value is shown in the numerical box immediately
below.
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User Defined Keys Setup window
In this window, you can specify the functions or parameters to be assigned to the User Defined keys.

NOTE

You can view and edit the INPUT CH 33–48 parameters only during editing online with the M7CL-48, or
only when “48” is selected as the Input Channel numbers in the Mixer Setup window during offline editing.

❏ CURRENT USER
Displays the name of the user currently logged into the M7CL console. If the M7CL has not yet been synchronized with the Editor, this field displays “ Administrator.”

❏ EDIT
Displays and enables you to specify the user level (Administrator, Guest, or Ext.User) of the User Defined keys
that you are editing.
“Ext.User” is the user who is currently logged into the M7CL console via a user authentication key stored on a USB
storage device. You can select this user only when the M7CL console is synchronized with the Editor.
NOTE

Ext.User’s User Defined key settings will not be stored in a session file.

❏ Function names
Select the functions or parameters you wish to assign to the User Defined keys.
Click a User Defined key to open the Parameter List dialog box.
For more information on the assignable parameters, please refer to the “M7CL Owner’s Manual” and the “M7CL
V2.0 Supplementary Manual.”
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Keyboard Shortcuts
Menu

Action

Key operation

Creates a new Session

Ctrl+N

Opens a previously saved Session

Ctrl+O

Saves the current Session

Ctrl+S

Undo

Ctrl+Z

Redo

Ctrl+Y

Closes the active window

Ctrl+W

Closes all windows

Ctrl+Alt+W

Tiles all windows

Ctrl+T

Cascades all windows

Ctrl+Alt+T

Opens the Master window

Ctrl+1

Opens the INPUT CH (CH1-16) window

Ctrl+Alt+1

Opens the INPUT CH (CH17-32) window

Ctrl+Alt+2

Opens the INPUT CH (CH33-48) window

Ctrl+Alt+3

Opens the ST IN window

Ctrl+Alt+4

Opens the MIX window

Ctrl+Alt+5

Opens the MATRIX window

Ctrl+Alt+6

Opens the STEREO/MONO window

Ctrl+Alt+7

Opens the MATRIX window

Ctrl+Alt+8

Opens the Selected Channel window

Ctrl+3

Opens the Library window

Ctrl+4

Opens the Patch Editor window

Ctrl+5

Opens the Rack window

Ctrl+6

Opens the Meter window

Ctrl+7

Opens the Group/Link window

Ctrl+8

Opens the Scene window

Ctrl+9

Synchronization menu

Opens the Re-Synchronize window

Ctrl+0

Library window or
SCENE MEMORY page
of the Scene window

Selects consecutive multiple items (memories)

Shift+click

Selects non-consecutive multiple items (memories)

Ctrl+click

Selects all memories in a section

Ctrl+A

File menu

Edit menu

Windows menu
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